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Overview

Welcome to   ViaPrint  !  
ViaPrint is an all purpose Windows Printing Utility.  Use ViaPrint for:

- Mailing Labels!  Handy pre-set AveryTM Laser Label sizes are easy to select for 
whatever label you want to create.
- Flyers!  Full page flyers are a breeze with ViaPrint.  Advertise your next garage
sale - sell your dog!
- Business Cards!  Using cardstock paper for you printer, create your own 
business cards!
- Cassette Tape Labels!
- Video Tape Labels!
- More!  Your imagination is your ViaPrint's only limit.

If you've been looking for something quick and uncomplicated to handle your custom 
printing needs, ViaPrint is for you.  We've packed lots of features into ViaPrint to make it 
as easy and fast to use as possible.
---------------------------------------------------------

---------------------------------------------------------
Features Include:
---------------------------------------------------------

* "What You See Is What You Get" document design.

* Import your favorite Pictures.  Add up to 10 .BMP (Windows Bitmap) or
.WMF (Windows Metafile) pictures to your label or flyer.

* Print MAILING Labels using ViaPrint's Database Printing Capability!  
"Comma-Delimited ASCII" format, dBASE IV format, and the new ViaBase 
format are supported.

* Text Rotation!.  Rotate your text to any angle for attention grabbing 
headlines or tiny copyright notices.

* "Drag and Drop" text, box, and picture placement.

* Line Box and Picture Resizing.  Stretch your pictures and boxes to the 
size you need using your mouse.

* Easy to use, up front controls.  Make use of all your True Type fonts.

* Built in Font Viewer and Character Selector.  Use your "WingDing" or 
"DingBat" fonts for interest effects.

* Color capability.  Use colored fonts and boxes for special effects.
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---------------------------------------------------------
PROGRAM REQUIREMENTS:
---------------------------------------------------------
IBM Compatible Computer with an 80286, 386, 486, or Pentium processor running 
Microsoft Windows 3.x.
A hard disk drive.
A mouse is required.
A printer.
---------------------------------------------------------

---------------------------------------------------------
LICENSE INFORMATION:
---------------------------------------------------------

ViaPrint is a copyrighted, proprietary program offered "as is", without any warranty of 
merchantability or fitness for a particular purpose, performance, or otherwise; all 
warranties are expressly disclaimed.  By using ViaPrint, you agree that the author will not
be liable for any use of (or inability to use) or performance of this product, or for any 
damages whatsoever.  

The registered version of ViaPrint, ViaPrint Ultra, may be used on only one machine at 
any one time.  Site Licenses are available for multiple copies - see below.

This software is being distributed as Shareware.   You may use this program freely for 
thirty (30) days.  If you use it for longer than thirty days, you are required to register it with
the author for $29.50 US.  You may also copy and distribute this program, as long as all 
the files are distributed intact in a single archived file - and the conditions in the 
accompanying VENDOR.DOC are adhered to.  You may not sell this program, and you 
may charge only nominal fee for distribution not exceeding $8.00 a copy.
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REGISTRATION:
ViaPrint is Shareware.

(Note: The shareware version of ViaPrint produces printed documents 
and labels with the "watermark" - ViaPrint Unregistered -. The registered 
version, ViaPrint Ultra, doesn't print this watermark, of course.  This watermark 
will appear on the first label of each page.)

The registration fee for ViaPrint is $29.50 ($25.00 + 4.50 shipping and 
handling).  For your fee you will receive ViaPrint Ultra with the following:

* Notification of updates.  ViaPrint will be updated with new features 
and conveniences (and bug fixes) regularly.  Registration will insure that 
you receive notification of, and significant discounts on, all future 
updates.

* Technical Support.

* A printed ViaPrint Manual.  Our little 5" x 5" manual will make learning
and using ViaPrint a breeze.

* Full Picture and Angle Box Capability.  Use up to ten Picture Boxes 
and Angle Boxes per label!  The shareware version is limited to two of 
each.

* A full range of AveryTM Preset Label Templates.  The Shareware 
version of ViaPrint allows printing of only the first twenty Avery Label 
Templates.  The registered version lets you print them all!.

* A Viable Software Alternatives Shareware Distribution disk, with at 
least FOUR other shareware programs including the latest versions of 
our popular Windows games, World Empire II, Poke-It Poker!, and our 
new Label database for Windows, ViaBase (When ViaBase becomes 
available, probably January, 1994)

* A FREE - Completely free, no strings attached - REGISTERED 
version of our popular VGA arcade game, Heavy Water Jogger - 
complete with the coveted cheat codes!

* A certificate allowing you to purchase the JCSM Shareware 
Collectiontm CDROM for only $9.95 + s & h - a regular 19.95 value!  
Hundreds of megabytes of the best shareware around!  (Offer good until 
July, 1994)
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---------------------------------------------------

Register your copy of ViaPrint soon!

In the US and Canada:

   Send ONLY $29.50 for each copy needed (Site Licences are available: $25.00 each for 
quantities from 2 to 5; $20.00 each - 5 to 15 copies; $15.00 each - over 15 copies) to:

Viable Software Alternatives
PO Box 98134
Las Vegas, NV   89193-8134

  
   Or Call:

1-800-854-4902 with your MasterCard or VISA number.
   (Orders ONLY, please.  For Site Licensing info or other questions call 618-549-5227)

In Europe and the UK:

   Send ONLY Pounds:19.95 for each copy needed to:

The Thompson Partnership
Church Croft
Bramshall
Uttoxeter, Staffs
ST14 5DE

   Or Call:

         Phone +44 (0)889 564601
Fax     +44 (0)889 563219
BBS    +44 (0)889 568625
(MasterCard, Visa, American Express, Diner's Club)

An order form is provided under the file name "ORDERFRM.TXT". You can Open this file 
using Windows Notepad and print it.

For technical support call:  (618) 549-5227
  
Or I can be contacted via CompuServe at: 

Casey Butler, 72043,46

You can also register via CompuServe by entering "GO SWREG" and requsting 
product 2120...

Thanks for trying ViaPrint!

---------------------------------------------------
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Info On...
ViaPrint  's Main Edit Screen  
ViaPrint creates a label on the screen the same size as the label you want to print (see 
below, The "Page Setup" Window).  You then simply add Text Boxes (lines of text), 
Picture Boxes (.BMP or .WMF picture files), Angle Boxes (special text boxes that you can
rotate), and Line Boxes (decorative lines and frames to enhance your label), drag them 
around the screen label and resize them to look like you want - then print your labels, 
business cards, flyers, etc... on your printer.  It's that easy.

ViaPrint Object Priority

Text Boxes, Picture Boxes, etc... are treated as objects in ViaPrint.  As such, each has 
its own place in the scheme of things and each has a priority.  Think of this priority as a 
physical position on the screen depth-wise.  Line Boxes have the lowest priority - all 
other objects are placed on top of Line Boxes.  Angle Boxes come next, then Text 
Boxes, and, finally, Picture Boxes have the highest priority in ViaPrint.  That means that a
Picture Box will cover any Line Boxes, Angle Boxes, or Text Boxes that it is placed on top 
of - unless you've selected "Imbed Picture Boxes"  (See below under ViaPrint Controls).

To access a Line Box that is entirely hidden by an un-imbedded Picture Box, you'll need 
to move the Picture Box so the Line Box is visible.

Individual objects have priorities too.  These are changeable, however - see below under 
the "To Front" and "To Back" buttons.

Text Boxes, Picture Boxes, Angle Boxes, and Line Boxes
Working with the Text Box:

The ViaPrint Label Edit Screen is easy to use and self-explanatory.  After setting the size
of the label you wish to create using the Page Setup Window's "Label Width" and "Label 
Height" text entry boxes (for Custom Labels), or selecting the desired Avery Label 
Template, the Label area at the bottom of your screen will change to that size.

Initially you'll see a single TEXT BOX that says "Blank Line" and that's highlighted by red 
resizing tabs. 

Only the left and right resizing tabs on Text Boxes have any effect in ViaPrint.  They 
change the Text Box's width.  To change the size of a Text Box, click on the left or right 
resizing tab and hold down the left mouse button to "drag" the box until the box is as wide
as you want it.

As you enter text into the edit box, the text will also be displayed in the current Text Box, 
the text wrapping and the height of the Text Box expanding as you type.
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You can move the Text Box to any position on the Label by placing the mouse cursor over
the Text Box (The mouse cursor will change from a "cross hair" to an "up arrow" when it 
is over a moveable object).  Then depress the left mouse button and, holding it down, 
"drag" the Text Box to the new location.  Indicators on the horizontal and vertical rulers 
will assist you in lining up Text Boxes evenly.  If you've selected "Snap To Grid" from the 
"Page Setup" Window, the Text Box will align itself to the current grid setting.

Use the Font Name, Font Size, and Font Style Options (Bold, Italic, and Underline) tools 
to display the text in your Text Box the way you want.  You can align the text in your Text 
Box by selecting "Left", "Right", or "Center" - use the "Text" Menu from the ViaPrint Menu
Bar, then select "Alignment".

Use the Edit Text entry box in the upper left of your screen to change the text in the 
currently highlighted Text Box.

To add another Text Box, select "Add Text Box" from the "Object" Menu.

Working with the Angle Box:

Angle Boxes have the capability to display text at an angle.  Otherwise they are much like
Text Boxes, but:

1. Because of their rotation capabilities, Angle Boxes are a wide as they are high,
that is, as wide as the text they hold.  This makes them cumbersome as they will "cover" 
any Line Boxes they're over.  For this reason, it's usually a good idea to add Angle Boxes 
after other objects have been created and placed on the label.

2. Angle Boxes print only in Black.

3.  When an Angle Box is currently selected, a rotate control will appear next to 
the "Viable" button on your screen.  Use this control to change the angle at which your 
text is displayed.

Use the Font Name and Font Size tools to display the text in your Angle Box the way you 
want.  ALL FONTS ARE NOT ROTATEABLE!  Most True Type fonts will rotate fine.  
(Printout results for Angle Boxes are not yet always accurate! Always test by printing first 
to scrap paper.)

Use the Edit Text entry box to change the text in the currently highlighted Angle Box.

To add another Angle Box, select "Add Angle Box" from the "Object" Menu.

Picture Boxes:

This same Add, Drag and Drop technique is used to move Picture Boxes and Line Boxes 
around on your Label.  The resizing tabs on these two DO affect each, however.

To add a picture to your Label, select "Add Picture Box" from the "Object" Menu. From 
the "File Type:" List Box in the File Window, choose either .BMP or .WMF (Windows' 
MetaFile).  Then select the picture file you want to display, press "Okay", and drag it and 
resize it until it's displayed as you wish.

To resize a picture, move the mouse cursor over the resizing tab that corresponds to the 
direction you want to "stretch" or "shrink" the Picture Box.  When the mouse cursor is 
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over the resizing tab it will change to a double arrow.  Press the left mouse button, and, 
holding it down, drag the corner or edge of the Picture Box until it's the size you want.  Be
patient, resizing .BMP pictures takes time!

Line Boxes:

To create a Line Box you first need to draw the size and position of the Line Box on your 
Label.  Move the mouse cursor to the point where you want the upper left corner of the 
Line Box to be.  The mouse cursor MUST be in the shape of a "cross hair" - if it isn't, that 
means you're already on top of another Line Box, Text Box, Angle Box, or Picture Box.

Press the left mouse button and, holding it down, drag the mouse cursor down and to the 
right.  As you do this a blue box outline will appear on the Label.  When this box is the 
approximate size of the Line Box you want to create, release the mouse button.

A box will appear - but not yet a Line Box!  When you release the mouse button you'll 
notice that the "Draw Line Box" selection in the "Object" Menu is selectable.  Click on this
selection and your Line Box will be created and highlighted - ready to reposition and 
resize as you wish.

The color of Line Boxes can specified using the "Color" selection from the "Object" Menu.
When a color other than white is selected for a Line Box the box appears opaque - you 
can't see through it.  When white is chosen, the Line Box will appear transparent.

Moving Or Copying A Group Of Objects
To move a group of objects in ViaPrint you first need to draw a box around all of the Text
Boxes, Picture Boxes, Angle Boxes, and Line Boxes you want included in the copy or 
move.  Place the mouse cursor over the point where you want the upper left corner of the
box to be.  The mouse cursor MUST be in the shape of a "cross hair" - if it isn't, that 
means you're on top of a Line Box, Text Box, or Picture Box.

With the cursor shaped as a cross hair, press the left mouse button and, holding it down, 
drag the mouse cursor down and to the right, including all of the objects to be moved or 
copied within your box.  As you do this a blue box outline will appear on the Label.  Now 
release the mouse button.

A Move Box will appear around your selected Text Boxes.

Moving:  To move the selected objects, move the mouse cursor onto the center of this 
Move Box and drag it to the new position.  All Text Boxes, Picture Boxes, Angle Boxes, 
and Line Boxes within will be repositioned.  You can continue repositioning until you're 
happy with the results.  When that happens, just click anywhere on the Label OTHER 
than over the Move Box, or click on the "End Move" selection under the "Draw Line Box" 
function in the "Object" Menu, and the move will be completed.

Copying: To copy the selected objects, click on the "Copy Object(s)" Function in the 
"Edit" Menu.  The objects you drew your line around will be copied to the clipboard, ready
to "Paste".
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Setting Label Size And Page Setup 

There are thirty Preset AveryTM Label Page Templates built into ViaPrint, as well as a "Full
Page Flyer" size and a customizable size.  Version 2.14 also contains the A4 Avery label 
templates for use with metric measurements.

The "Page Setup" Window

Setting Your Label Size and Specifications

Avery PreLoaded Templates

To select one of the Preset Avery Label sizes, select "Label Size and Page Setup" from 
the "Page" Menu and the "Page Setup" Window will appear.  From the "Avery 
PreLoaded Templates" list box at the bottom of the window, select which Avery size you
want - or choose "Custom" to enter your own measurements.  

If you require metric label sizes, first click on the "A4" button in the "Page Size" menu 
box.  This will cause the Avery metric label sizes to be displayed in the "Preset" list box.

Note: The shareware version of ViaPrint will not let you print the last ten Avery label 
sizes.  You can get around this limitation, however, by noting the width and margins 
shown and entering them as a "Custom Label".   

You can change the Top Margin, Bottom Margin, Left Margin, and Right Margin text 
boxes to compensate for differences in Printers.  Experiment using scrap paper to get 
your margins correct for final label printing.
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You can also set the "gutter" between labels here.  The gutter is the unused portion of the
page that appears between the labels themselves.  In the "Page Setup" Window enter 
gutter sizes in the "Vertical Divider" and "Horiz. Divider" entry boxes.

Unless you've selected the "A4" page size, the Page Setup measurements are in 
INCHES, so a 1/2 inch left margin would be entered as ".5", a 3/4 inch margin as ".75", 
and so on.

IMPORTANT NOTE:  ViaPrint 2.14 allows landscape printing.  You must set your 
Windows Print Manager to "Landscape" mode - and enter the proper "Page Length" and 
"Page Width" in the "Page Setup" Window.

Custom Templates in Version 2.14

Once you've entered all the measurements for a "Custom" or Avery label (margins, page 
size, etc...), you can save the new label "template" by selecting the "Add" button in the 
"Custom Templates" box.  You'll be prompted for a template name and be allowed to 
enter a short description of the template.  A few custom templates have been provided for
legal size flyers and a few envelope sizes.  The "Info" button is used to view the template 
description and the "Delete" button deletes the selected Custom Template.

ViaPrint User Preferences

Setting A "Printer Offset" 

If your printer has its own internal page size, you'll notice that your label margins don't 
print correctly.  For example, your labels may print fine, but are not centered on the page. 
A number in the "Printer Top Offset" box controls the top margin for all labels.  If your 
printout is a quarter of an inch to high or to low, enter .25 or -.25 (negative numbers are 
okay here) in this box.  The same technique works for the "Printer Top Offset".

Grid Settings And Using A Layout Grid

Since Objects in ViaPrint can be moved anywhere on a label (that's why it's so fast and 
easy to use) aligning objects properly can be a tedious job.  ViaPrint provides a label 
"grid" to help alleviate this situation.

The label grid causes your Text Boxes, Angle Boxes, Picture Boxes, and Line Boxes to 
automatically be "dropped" in incremental positions on your label.  For example, if you've 
set the grid spacing to .25 (one quarter) of an inch, any object you "drop" will adjust itself 
to that spacing.  If you "drop" a Text Box directly below another, the box you "dropped" 
will align itself .25 inches below the first.

There are three contols that affect the label Grid:

The "Show Grid" check box:  Selecting this will cause the grid to be drawn on your label. 
(Large labels with small grid spacings take some time to update with a visual grid, so be 
patient.)

The "Snap To Grid" check box:  If this check box is selected all objects will automatically 
align themselves to the grid when "dropped".  If the check box is unselected, objects will 
stay where "dropped".
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The "Grid Spacing" entry box:  The number you enter here determines grid spacing.  Grid
spacing less than .05 inches will not be shown even if the "Show Grid" check box is 
selected.  The entire label would be blue!

Using the label grid will speed up label design considerably.

Setting A Default Font

Use the "Default Font" drop down list box to select the font you want ViaPrint to start up 
with.  ViaPrint will automatically use this font when loaded.  

Entering A "Saved Label" Directory Path

The "Path For Saved Labels" box is used to tell ViaPrint in what directory you want your 
labels saved.  When a valid directory (path) name is entered here, the "Open" and "Save"
windows will assume you want that directory.

Printing Your Label Document
Experimentation is the best way to get your labels lined up on the page correctly before 
printing and possibly wasting some expensive label sheets.

The "Label Print Configuration" Window

If you are printing a Custom Label size, before selecting the "Print" Button be sure your 
margins are set correctly in the "Page Setup" Window.  After selecting "Print", the "Label 
Print Configuration" Window will appear with a sample label page.

If you want to configure your printout (start printing at a certain label on the page, print 
only a certain number of labels, enter Database specifications, etc...), you can do it here.

On the right side of the Label Print Configuration Window is a small version of your label 
page.  To begin print at a label other than the first on the page, click on the position of the 
label where you want to start printing.  

You can also specify the number of labels per page to print - and the number of pages 
(unless you're printing from a database).  When everything looks right, press the "Print" 
command button.

ViaPrint   Database Options  

If you have selected a database to print labels from, two additional controls are visible on 
the screen: the "Start at Record#" entry box and the "Set Conditional Fields" Button.  If 
you want to start printing labels from your database at any record other than the first, 
enter the record number in the "Start at Record#" entry box.
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The "Set Conditional Fields" Window

You can set up to three Conditional Sentences that filter the printing of labels from a 
database in ViaPrint.

To set conditions on printing labels (the field in the database must match the information 
you enter here for the condition to be "true" and the label to be printed), click on the Field 
Name List Box that appears after the prompt "Print Label If:", and select the field you 
want to conditionalize.

Eight conditions are available and are accessed by pressing the "Equals" command 
button.  As you click on this button its caption will change to other conditions.  They are: 
"Doesn't Equal", "Is Greater Than", "Is Less Than", "Contains", "Doesn't Contain", "Is 
Blank", "Is Not Blank", and, finally, back to "Equals".

After selecting the condition, enter the text that must be matched in the entry box to the 
right of that conditional command button.  This is the text that must be matched within the
database record if that record is to have its fields printed within your label.

The varying conditions and their effects are listed below:

Equals: In order for a record to be printed as a label, the database field must 
exactly match the text you entered to the right of the conditional
command button (the comparison ignores case).

Doesn't Equal: The field must be different from the text you entered.

Is Greater Than: The field must be alphanumerically greater than the text you 
entered.  

NOTE: If the database you are using is a dBASE IV compatible 
database or a ViaBase database, the field will first be converted 

to its intended type (ie. Numeric, Date, etc...) before the comparison is
made. Because there is no way for ViaPrint to know what type of fields 
are contained in a "Comma-Delimited ASCII" database, all fields 
within them are compared as characters (alphanumerically).

Is Less Than: The field must be alphanumerically less than the text you 
entered.  See Note above.
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Contains: The field will be scanned tor the text you've entered.  If the text is 
found anywhere within the field, the record will be printed.  For 

example, if the field you are conditionalizing contains the
text"1/5/93" and you enter "93" as the conditional text, the label will 
be printed.

Doesn't Contain: The field will be scanned tor the text you've entered, but the 
record will be printed only if the text was not found.

Is Blank: The record will only be printed if the field is blank.

Is Not Blank: The record will only be printed if the field is not blank.

A complete Conditional Sentence might look like this:

Print Label If:  Last_Name   Equals   Smith

or:

Print Label If:  Date_Ordered Is Less Than    1/1/93

Between the three Conditional Sentences in the Set Conditional Fields Window are 
command buttons that change from "And" to "Or" and back to "And" again.  These give 
you greater flexibility in conditionalizing your printout.

For example, if you set your Conditional Sentences to read...

Print Label If:  Last_Name   Equals   Smith

Or If:  Last_Name   Equals   Jones

And If: Date_Ordered  Is Less Than    1/1/93

...ViaPrint will print all records of anyone named Smith or Jones that ordered after 
January 1, 1993.

To print ALL records in a database, be sure all that all Field Name List Boxes in the "Set 
Conditional Fields" Window are set to "Don't Use" (The default).

--------------------------

All possible within our current means was done to insure printer compatibility.  If you have
a problem, write us giving your printer brand and model, and we'll see what we can do.
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ViaPrint   Controls  
File Menu
The "New Label Design" Option

Selecting this option will clear the current label of all Line Boxes, Picture Boxes, and Text 
Boxes, then place a single Text Box at the lower right of the visible part of the label with 
the words "Blank Line".

The "Open Label Design" Option

The "File" Window (Used for all disk operations)

Use this function to load a previously saved label into ViaPrint for editing or printing.  
Select the label you wish to load from the list of files on the File Window that will appear 
and press "OK".

The "Save Label" Option

Select this option when you're ready to save your work.  If the label is being saved for the
first time a File Window will appear.  Enter a name for the saved label and select OK.

The File Extension that ViaPrint uses for saved labels is ".LBL".

The "Save Label As" Option

Use this option to save the current label under a different name.

The "Print" Option

Click on this selection and the Print Configuration Window will appear.  See above under 
"Printing Your Label Document" for more information.

The "Printer Setup" Option

Clicking on this selection will cause the Printer Setup Window of the Windows Control 
Panel to appear over the ViaPrint screen.  Use this Setup Window to configure your 
printer for page size, print quality, etc...
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The "Exit" Option

Selecting this option will end your ViaPrint session and return you to Windows.  If you've 
not saved the current label since changing it, you'll be given the chance to do so before 
the program ends.

Edit Menu

The "Copy Object Contents" Option

Selecting this option will copy the contents of the currently selected Text Box, Picture 
Box, or Angle Box to the clipboard.  Note:  You can copy picture displayed in a Picture 
Box for pasting into other programs, but you cannot paste pictures directly into Picture 
Boxes.

The "Copy Object(s)" Option

Selecting this option will copy the currently selected object into the clipboard.  If you've 
drawn a Move Box around several objects when you select this option, all included 
objects will be copied.

The "Paste" Option

Selecting this option will "paste" the contents of the clipboard onto the ViaPrint Label Edit
screen.  If a group of objects was pasted, a Move Box will appear around the objects so 
you can place them on your label where you wish.

The "Select Character" Option

This option activates ViaPrint's Font Viewer and Character Selector.  The character set 
for the font you're currently using will be displayed.  To select a character to include in 
your current Text Box, click on the little box ABOVE that character.  The characters you 
select will appear at the top of the window.  To clear these characters, press the "Clear" 
button.

Any characters you select will be placed in your Text Box when you "Close" the Font 
Viewer.  If no characters were selected, the selected Text Box will remain unchanged.

The "Delete Object" Option

Selecting this option will delete (remove from the label) the currently highlighted Text Box,
Picture Box, Angle Box, or Line Box.  After deletion, the highlight will settle on the last 
edited Text Box.  Careful with this option - there's no Undo feature in ViaPrint yet!

You CANNOT delete the last Text Box on a label.
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Object Menu

The "Add Text Box" Function

Pressing this button will cause a new Text Box to appear on the lower right corner of the 
visible part of your label.  The new Text Box will have the same properties, ie. width, font, 
font size, font style... as the Text Box that is currently selected when you pressed the 
"Text Box" button.

When the new Text Box appears, it will read "Blank Line".  Just enter your new text into 
the Edit Box.

ViaPrint allows up to 60 Text Boxes per label.

The "Add Picture Box" Function

Pressing this button with your mouse causes a file window to open.  Select the .BMP 
or .WMF picture file that you want to display on your label, and press "OK" on the file 
Window.

The picture you selected will be placed in a Picture Box and centered in the visible part of
the label you are editing.  Move the picture to the location you want it to appear and 
resize it as necessary.

The registered version of ViaPrint allows up to 10 Picture Boxes per label, the shareware
version only two.

The "Add Angle Box" Function

Pressing this button with your mouse adds an Angle Box to your label in the same way 
that a Text Box is added.

The registered version of ViaPrint allows up to 10 Angle Boxes per label, the shareware 
version only two.

The "Imbed Picture Boxes" Option

This option places the images your Picture Boxes contain into the ViaPrint label 
background.  This allows you to see other objects and place them properly without the 
Picture Boxes hiding them.

NOTE:  If it is turned on, you must turn off Picture Box imbedding before you can move or
resize your pictures.  

The "Draw Line Box" Function

This option is not accessable until you have outlined the position for your Line Box on the
label.  To create a Line Box, move the mouse cursor over the label and press the mouse 
button when the CROSSHAIR is at the point where you want the upper left hand corner 
of the Line Box to be.  Holding the mouse button down, drag the mouse down until the 
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Line Box outline is the size you want it, then release the mouse button.

At this point the Draw Line Box function will operate.  Select it, and your new Line Box will
be highlighted, ready to move or resize as necessary.

The "Center Object" Function

Selecting this option will cause the currently selected or highlighted Text Box, Picture 
Box, Angle Box, or Line Box to be centered within then current label.

If you change the font or font size of a centered Text Box or Angle Box, or resize a 
centered Picture Box or Line Box, you'll need to re-center them again using this option.

The "Snap To Guidelines" Function

The "Snap To" option has no effect unless the ViaPrint Guidelines are visible.  When the
Guidelines are visible, selecting this option causes the currently selected Line Box or Text
Box to position itself in relation to the Guideline settings.  

If only the Vertical GuideLine is visible, then the Text or Line Box will only align itself 
vertically.  If only the Horizontal GuideLine is visible, then the Text or Line Box will only 
align itself horizontally.

The "To Back" Option

This option changes an object's priority on your label.  For example, if you have two Line 
Boxes that overlap one another, pressing the "To Back" option will cause the current Line 
Box to be displayed under the box it overlaps.  This option has no effect on Picture 
Boxes.

The "To Front" Option

This option changes an object's priority on your label.  For example, if you have two Line 
Boxes that overlap one another, pressing the "To Front" option will cause the current Line
Box to be displayed over the box it overlaps.  This option has no effect on Picture Boxes.

The "Object Color" Option

This option is used to change the color of text in a Text Box or the color of the inside of a 
Line Box.  The Color option has no effect on Picture Boxes or Angle Boxes.
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Page Menu

The "Label Size and  Page Setup" Option

When you select this option, ViaPrint's Page Setup Window will appear.  Here you can 
select from several preset Avery Label sizes, select a full page flyer, or select "Custom", 
an option that allows you to define your own label sizes and margins.

For a more detailed description of Page Setup and margins in ViaPrint, see "How To Set 
Label Size And Setup Page" and "How To Print Your Label Document" elsewhere in this 
Manual.

The "Label Border" Option

When you click on this selection, you'll find three choices for adding a line border to your 
label.  Click on "None", "Single", or "Double" border, and the appropriate border will be 
drawn on your label.

The "Preview" Option

This option activates ViaPrint's Preview Window, which is especially useful when editing 
large labels or flyers that do not fit on the Windows screen.  Horizontal and Vertical 
Rulers are provided for comparison purposes.

Small labels can be viewed here as they will be printed on a sheet of 8 1/2 by 11 Label or
Card Stock.

Font sizes on the Preview Window vary, so don't depend entirely on this view.  Print 
test pages on your printer using scrap paper to get an accurate idea of what your printed 
sheet will look like.

Text Menu

Changing Font Style

Three Font Styles are available in ViaPrint, Bold, Italic, and Underline.  To change the 
style a particular font in the selected Text Box is displayed in, select from "Normal", 
"Bold", "Italic", or "Underline".  The selected Text Box will immediately reflect your 
change of font style.

Aligning Text In A Text Box

When you select "Alignment" from the Text Menu, you'll find three choices for aligning 
the text in the current Text Box.  Click on "Left", "Right", or "Center", and the appropriate
alignment will take effect in your Text Box.
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Database Menu

The "Use Database" Option

When you click on this selection a File Window will appear/.  From the "File Type:" list box
choose the type of database file you wish to work with, then select which file from list of 
files that appears.  When you've selected a database this option will change to 
"Database Off" and the other three options under this menu will be accessable.

The "Set Conditional Fields" Option

See above under "Printing Your Label Document" for a description of this option.

The "View Database" Option

When you click on this selection, the database you've selected will be displayed record 
by record.  Only records that match the Conditional Sentences you've created will be 
shown.  See above under "Printing Your Label Document" for more information.

The "Insert Field" Option

While you can enter Field Names between brackets yourself, the "Insert Field" option is 
provided to conveniently do this for you.  Select the "Insert Field" option and select the 
Field Name you wish to add from the List Box that appears.  You can then choose to 
create a new Text Box for that Field Name or just add the Field Name to the currently 
selected Text Box.

Add text, carriage returns, and punctuation between the fields as necessary by using the 
Edit Text box.

Help Menu
The "Documentation" Option

Displays program documentation.

The "ViaPrint Manual" Option

Displays this manual.

The "Order Form" Option

Displays ViaPrint's Order Form Window.  Fill this form out and select "Print" to order a 
copy of ViaPrint Ultra.
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ViaPrint   Toolbar Controls  

The Edit Box

The "Edit Box", in the upper left corner of ViaPrint's Tool Bar, is where text is entered.  
Any text you type here is recreated on the label you are currently editing.  Once text is 
entered, you may use the mouse to "drag" the text into the  position you want.

Pressing the [ENTER] key after entering your text will cause a new line to be started in 
the current Text Box.

Text entered in the Edit Box appears in the current Text Box as you type.

Changing Fonts

To change the font that the text in the selected Text Box is displayed in, click on the arrow
beside the current font name.  A list of the fonts installed in your Window System will drop
down.  Click on the new font name and the currently selected Text Box will immediately 
change to that font.  The Text Box will resize itself accordingly.

Changing Font Size

To change the font SIZE that the text in the selected Text Box is displayed in, click on the 
arrow beside the current font size.  A list of the font sizes available will drop down.  Click 
on the new font size and the selected Text Box will immediately change to that font size.  
The Text Box will resize itself accordingly.

The ViaPrint Shortcut Icons

Most Menu functions are duplicated as Shortcut Icons in version 2.14.  From left to right 
the Icons initiate the following Menu Options:  Bold, Italic, Underline, Align Left, Align 
Center, Align Right, Add Text Box, Add Picture Box, Add Angle Box, New Label 
Design, Open Label Design, Save Label, Print, Copy Object(s), Paste, Use 
Database, Label Size and Page Setup, and, finally, Preview.

Other Controls

The ViaPrint Guidelines

The Guidelines are normally not visible.  To set a Guideline to a particular measurement 
on your label, move the mouse pointer over either the horizontal or vertical rulers on the 
side and top of the label.

Click the left mouse button and the Guideline will appear at the point on the ruler that you
specified.
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To remove the GuideLines, press the "G" Button at the intersection of the two rulers, and 
the GuideLines will disappear.  Pressing the "G" button again will make the Guidelines 
reappear.

Pressing the "Snap To" Button while one or two of the Guidelines are displayed will cause
the current Text Box or Line Box to align itself to the Guidelines.

Keyboard Functions

A mouse is required in ViaPrint, however the keyboard will make some operations easier.

To move an object the amount of space that you've set for the label grid, use SHIFT plus 
the ARROW keys.  

To change "focus" immediately to the "Edit" box, press F2.  

To change which object is currently selected (highlighted) press CTRL plus TAB.

This manual is available at most times in the program by pressing F1.

Using   ViaPrint   To Print Database Labels  

(Be sure to check out the sample files included with ViaPrint.  Several of these are 
examples of database printing)

ViaPrint 2.14 allows you to print labels containing data from three types of Database 
files, "Comma-Delimited ASCII", "dBASE IV Format", and Viable Software's own 
ViaBase.  Most other Database programs have the capability of saving their databases in
one of the two former formats. 

Databases are lists of information.  Your telephone directory is a database!  Database 
lists consist of Records and Fields.  Using the telephone directory as an example, a 
telephone directory record is the entire entry for one person or household.  That record 
is made up of indiviual fields - which include that person's name, their address, and their 
telephone number.

As another example - you may have a database that lists and keeps track of your Video 
Library.  In your database each movie has its own record.  In each record are fields that 
contain the name of the movie, what the movie is rated, its release date, who directed it, 
etc...

Fields are given names.  For example, the field containing the movie title would be called 
"Movie Name" - the field containing the name of the director would be called "Director", 
and so on.
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In ViaPrint, Field Names for dBASE IV and ViaBase fields will reflect the names you 
gave them when you created them in your database.  If you named a field "Director" in 
your database program, you'll also call that field "Director" in ViaPrint as you layout your 
custom labels.

Comma-Delimited ASCII fields on the other hand, are assigned names in ViaPrint.  The 
first field in a record is given the name "Field1", the second "Field2", and on through until 
all the fields in a record have been named.

This means, when working with a Comma-Delimited ASCII Database File, you need to 
know what the fields are!  ViaPrint tries to assist by reading the first record in the 
database and displaying each field's contents along with the field name.

The rest of this section will assume Comma-Delimited ASCII field names - just to help 
you get used to them.

In ViaPrint field names can be embedded within Text Boxes.  In order to indicate the 
presence of a field name in the Text Box, "lesser than" (<) and "greater than" (>) brackets
must be placed at the beginning and end of the field name.  For example, entering 
"<<Field10>>" anywhere in a Text Box will cause the data in the tenth field of the current 
database record to be printed in place of the field name.  (As, if you're using a dBASE IV 
file, "<<Movie Name>>" would cause the actual movie title field to be printed on the 
label.)

Example:

Your movie database contains three records, each consisting of four fields:

Field1 (Movie Name)  Field2 (Release Date)  Field3 (Rating)  Field4 (Director)
           

     Record 1

Gargoyles!         1989                          PG13              Sam Jones

     Record 2

Blue Moon         1992                          PG                  Phil Philadendron

     Record 3

Gone With The Rain  1939                           G                    Jim Germain

In a Text Box on your label you enter: "<<Field4>> directed <<Field1>> in <<Field2>>. 
The film was rated <<Field3>>."

When you print your labels, using your Movie Database, the above Text Box will be 
printed as:

First Label:     Sam Jones directed Gargoyles! in 1989.  The film was rated PG13.
Second Label: Phil Philadendron directed Blue Moon in 1992.  The film was rated PG.
Third Label:    Jim Germain directed Gone With The Rain in 1939.  The film was rated G.
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Each instance of "<<FieldX>>" has been replaced with the appropriate data from fields in 
your database!

A Step-By-Step Walkthrough For Printing A Database:

Start ViaPrint!  When the Main Edit screen appears, select "Label Size and Page Setup" 
from the "Page" Menu and select or enter the size of label you're going to create - then 
Close the "Page Setup" Window.  Be sure to set the grid feature in the "Page Setup" 
Window if you want automatic alignment of your text boxes.

Now select "Use Database" from the "Database" Menu.  A window will appear requesting 
which format you wish to use.  Select the format and the File Window will appear.  Now 
select the database you want to use with your labels and press "OK".

The "Insert Field" option under the "Database" Menu will now be enabled.  While you 
can enter Field Names between brackets yourself, the "Insert Field" option is provided
to conveniently do this for you.  Select "Insert Field" and choose the Field Name you wish
to add from the List Box that appears.  You can then choose to create a new Text Box 
for that Field Name or just add the Field Name to the currently selected Text Box.

Add text, carriage returns, and punctuation between the fields as necessary by using the 
Edit Text box.

Continue adding Field Names, text, pictures, and boxes - and changing their font and 
style - until the label is satisfactory.  Remember, when the field name is replaced by 
data from your database when the labels are printed - the length of the text will 
change.  Be sure and design your label taking this into account!

Example of an address label Text Box (Using ViaBase Field Names for clarity):

 

Because all the field names are in one Text Box, if a field is blank that field and the space
or carriage return that follow it will not be printed.  This prevents your labels from having 
blank lines.
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When your text is formatted, select "Print" from the "File" Menu.  Specify which database 
record to start printing with, where on the page to start printing, and how many records 
(labels) you'll be printing - you can even specify which labels by setting Conditional 
Sentences (see above under "Printing Your Label Document")!.

That's it!  You've now printed from a database... this feature will give you real printing 
power!  Experiment a little and soon you'll be printing mailing labels from ViaPrint rather 
than your database or word processor!

Using A Database To Print Numbered Labels:  (See EXAMPLE9.LBL)

If you are printing disk labels and you want to number each label easily, you can create 
an ASCII "database" of numbers in WIndows Notepad that looks like this:

"1" {Enter]
"2" {Enter]
"3" {Enter]
"4" {Enter]
"5" {Enter]

The above assumes you want to print 5 numbered labels.  Save the database (just a 
Notepad document) as "NUMBERS.TXT" and create your label in ViaPrint.

Now select "Use Database" from the Database Menu.  In the file window that comes up, 
specify a file type of "*.TXT".  Locate your "NUMBERS.TXT" file and double-click on it.  A 
message will appear informing you that "NUMBERS.TXT is in use" and that each record 
consists of one field.

Now add a Text Box and place it where you want the numbers printed.  Enter:

Disk <<Field1>> of 5

...into the text box.  Now print your labels.  The numbers from your database will replace 
the word "<<Field1>>" on the printed label and you have your numbered labels!

ViaPrint 2.14 allows you to enter the number of label copies you need per printed 
database record.  To print out 5 sheets of numbered 3.5 inch disk labels, you would 
specify nine (the number of 3.5 labels on an Avery sheet) copies of each label in the Print
Configuration Window.  The first sheet will contain 9 labels that that read "Disk 1 of 5", the
second sheet, 9 labels that read "Disk 2 of 5", and so on.

ViaPrint saves the location of your database file with your label, so that when you next 
open it, that database will automatically be "in use" for that label.
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What's New For Version 2.14
Below is a summary of the additions made to Version 2.14:

Command Line Argument support.  You can now load a specific label when you start up 
ViaPrint by entering the file's path and file name after the command line in the 
"Properties" Window.  For example, "C:\VIAPRINT\VIAPRINT.EXE C:\VIAPRINT\
EXAMPLE4.LBL".  This line entered in the "Command Line" box of the Program 
Manager's "Properties" WIndow for a ViaPrint icon would cause the label named 
"EXAMPLE4.LBL" to be loaded when ViaPrint is run.

Font Viewer: The toolbar button with a camera on it, next to the font list box, let you select
or review your fonts visually if you wish.

User Preferences:  The Page Setup Window now has several fields for user preferences. 
They control printer offsets, grid settings, default font, and the default path used for 
saving labels.  Settings entered here are the default startup settings used by ViaPrint.

The Ability to Save Custom Templates: You can now save templates that you create in 
ViaPrint for use later.

Label Copies:  You can now specify the number of copies you want printed for each 
database label.

Several other small changes have been made, along with a few bug fixes.  We hope you 
enjoy ViaPrint!
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